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LAMPIRAN 1 

SENYAWA FLAVONOID DAN SUMBERNYA 

Tabel VII. 1 

 Daftar senyawa Flavonoid dan sumber tanamannya 

No. Falvonoid Sumber Tanaman 

Flavon 

1. Apigenin Petroselinum 

2. Baicalein Scutellaria 

3. Chrysin Populus 

4. Luteolin Robinia  

5. Scutelarein Scutellaria  

6. Hispidulin Ambrosia  

7. Chrysoeriol Reseda  

8. Tricetin Eriodictyon  

9. Tangeretin Diosma  

10. Wogonin Lathyrus  

11. Rhoifolin Triticum 

12. Diosmetin Daun Peterseli 

13. Acacetin Tetracera indica 

14. Tricin Jeruk Nipis 

Flavonol 

15.  Galangin Alpinia  

16.  Fisetin Rhus  

17.  Kaemferol Delphinium  

18.  Kaemferide Alpinia  

19. Robinetin Robina  

20. Herbasetin Gossypium  

21. Quercetin Quercus  

22. Ramnetin Rhamnus  

23. Isoramnetin Cheiranthus  

24. Myricetin Myrica  

25. Querstagenin Tagetes 

26. Gossypetin Gossypium 

27. Isoquercetin 

Apel, teh, tomat, anggur merah, cerry, bawang, brokoli, buah 

peel, letus, gandum, asam citrus, mangga 

28. Ramnazin 

29. Rutin 

30. Morin 
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LAMPIRAN 1 

(LANJUTAN) 

 
Tabel VII.1 

Lanjutan 

 

No. Flavonoid Sumber Tanaman 

31. Pachypodol 
 

Isoflavon 

32. Daidzein Pueraria  

33. Formononetin Ononis  

34. Genistein Genista  

35. Biokanin A Cicer  

36. Orobol Orobus  

37. Tectorigenin Iris  

38. Baptigenin Baptisia 

Flavanon 

39. Pinocembrin Pinus  

40. Liquiritigenin Glycyrrhi 

41. Narigenin za Prunus  

42. Sakuranetin Prunus  

43. Eriodictyol Eriodictyon  

44. Hesperetin Prunus 

45. Homeriodictyol Jeruk Bali 

46. Parietin 

47. Epigallocatechin  Camellia sinensis 

48. Catechin 

49. Naringin Jeruk Bali 

Dehidroflavonol 

50. Pinobanskin Pinus   

51. Aromadendrin Eucalyptus  

52. Fustin Rhus 

53. Taksifolin Pseudotsuga 

BiFlavonoid 

54. Agathisflavone Agathis 

55. Cupresuflavone Cupressus  

56. Ginkgetin Cupressus  

57. Siadopitisin Ginkgo  
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LAMPIRAN 1 

(LANJUTAN) 

 
Tabel VII.1 

Lanjutan 

 

No. Flavonoid Sumber Tanaman 

58. Robustaflavone Ginkgo  

59. Hinokiflavone Agathis  

60. Ochnaflavone Cupressus  

61. Amentoflavone Ochna 

Khalkon 

62. Isoliquiritigenin Acacia 

63. Khalkonarigenin 
Salix(sebagai 2’-O-glukosida) 

64. Butein Acicia  

65. Okanin Acicia 

66. Phloretin 
 Tomat, Strawberry 

67. Phlorizin 

Auron 

68. Sulfuretin Bidens  

69. Aureusidin Antirrhinum  

70. Maritimetin Bidens  

71. Leptosidin Coreopsis 

Antosianidin 

72. Apigenidin Rechsteineria  

73. Luteolinnidin Rechsteineria  

74. Pelargonidin Pelargonium  

75. Cyanidin Centaurea  

76. Peonidin Paeonia  

77. Delpinidin Delphinium  

78. Petunidin Petunia 

79. Malvinidin Malva 

80. Rosinidin Kacang  
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LAMPIRAN 2 

ALUR PENELITIAN PREDIKSI AKTIVITAS ANTIVIRUS 

DAN PREDIKSI DRUGLIKENESS 

 

 

 

 

 

 

 

 

 

 

http://scfbio-iitd.res.in 

Menginput file senyawa 

uji dalam bentuk (.pdb) 

atau (.mol2) 

Submit 

http://www.pharmaexpert.ru/passonline/ 

Menginput calonical SMILE 

senyawa uji dari pubchem 

Submit 

Gambar VII. 1 Alur prediksi aktivitas antivirus 

menggunakan PASS Online 

Gambar VII. 2 Alur prediksi druglikeness menggunakan situs online 
Lipinski Rule Of Five 

 

http://scfbio-iitd.res.in/
http://scfbio-iitd.res.in/
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LAMPIRAN  3 
 

ALUR PENELITIAN PREDIKSI FARMAKONINETIKA DAN 

PREDIKSI TOKSISITAS 

 

 

 

 

 

 

 

 

 

 

 

  

Struktur senyawa 

Pilih metode 

Memasukkan Canonical SMILES 

- Method > select a decision tree > 

Kroes TTC decision tree > Ok 

- Method > select a decision tree > 

Carcinogenicity by ISS  > Ok 

- Method > select a decision tree > 

In Vitro Mutagenicity > Ok 

 

Analisis 

 

http://preadmet.bmdrc.org/ 

Menggambar struktur 2D 

senyawa uji 

Submit 

Gambar VII. 3 Alur rediksi farmakokinetik menggunakan 

situs online Pre- ADMET 

 

Gambar VII. 4 Alur prediksi toksisitas menggunakan Toxtree 3.1.0® 
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LAMPIRAN 4 

ALUR PENELITIAN VALIDASI METODE MOLECULAR 

DOCKING 

 

   

 

 

 

 

 

 

 

 

Makromolekul 

- Diunduh dari PDB (resolusi <2Ǻ, SARS-

CoV-2 main protease, tidak mutasi) 

Reseptor Ligan 

- Dilakukan preparasi  menggunakan 

Discovery Studio Visualizer® 

 

- File>Open>masukkan 

makromolekul  yang sudah 

diunduh dari PDB 

- Script>Visualization>Publicati
on Quality 

- Script>Selection>Select Water 
Molecul>Delete 

- Script>Selection>Select Ligand 
>Delete 

- File>Save as>(reseptor.pdb) 
 

- File>Open> masukkan 

makromolekul  yang sudah 

diunduh 

- Script>Visualization> 
Publication Quality 

- Script>Selection>Select Water 
Molecul>Delete 

- Script>Selection>Select 
Protein Chains>Delete 

- File>Save as>(ligan.pdb) 

 

Preparasi makromolekul 

Validasi metode 
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        LAMPIRAN  3 

       (LANJUTAN) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

- File>Read Molecul> 

reseptor.pdb>Open 

- Edit>Changes>add 

Kollman Charges>Ok 

- Edit>Hydrogen>add>P

olar Only>Ok 

- Grid>Macromolecul>Ch

oose>klik 

“reseptor”>Select 

Molecul>file name 

“reseptor.pdbqt” 

Validasi metode 

- Dilakukan menggunakan AutoDock Tools  

Preparasi Ligan 

- File>Read Molecul> ligan.pdb>Open 

- Edit>Changes>Compute 

Gestaiger>Ok 

- Edit>Hydrogen>add>all 

hydrogen>Ok 

- Edit>Hydrogen>Marge non 

polar>Continue 

- Ligand>Input>Choose> klik 

“ligan”>Select Molecul for 

AutoDoock>Ok 

- Ligan>Torsion Tree>Detect Root 

- Ligan>Torsion Tree>Choose Root 

- Ligan>Torsion Tree>Choose Torsion 

- Ligan>Torsion Tree>Set Number Of 

Torsion 

- Ligan>save as “ligan.pdbqt” 

Pengaturan Grid box dan 

parameter docking - File>Read Molecul>Ctrl (ligan.pdbqt;reseptor.pdbqt) 

- Grid>Macromolecul>Choose>Klik “reseptor>Select 

Molecul>Yes>Ok 

- Grid>Set Map Types>Choose Ligand>Klik “ligan”>Select 

Ligand 

- Grid>Grid box> Center>Center On ligand>Atur volume & 

spacing>Close Saving Current 

- Grid>Output>Save name “dock.gpf” 

- Docking>Search Parameter>Genetic Algorithm>Number Of 

GA Runs (100)>Accept 

- Docking>Docking Parameter>Use Defuult>Accept 

- Docking>Output>Lamarckian GA (4.2)> Save as 

“dock.dpf” 

-  Running 

Preparasi Reseptor 
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LAMPIRAN  3 

(LANJUTAN) 

 

 

 

 

 

 

 

 

Gambar VII. 5 Alur penelitian validasi metode molecular docking 

  

Running 

- Run>Autogrid>Browser program 

pathname>masukkan autogrid4>input file 

“dock.gpf”>”autpgrid4.exe-P dock.gpf-1 

dock.glg&>Launch 

- Run>Autodock>Browser program 

pathname>masukkan autdock4>input file 

“dock.dpf”>” autodock4.exe-P dock.gpf-1 

dock.glg&>Launch 

 
Hasil Berupa File “dock.dlg” 
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LAMPIRAN  5 
 

ALUR PENELITIAN SIMULASI MOLECULAR DOCKING 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar VII. 6 Alur penelitian simulasi molecular docking 

 

- Dilakukan pada situs online SwissDock  

- file reseptor yang telah dipreparasi dalam format file 

(.pdb) diinput pada kolom target.  

- file “ligan.mol2” hasil preparasi ligan uji diimput  

pada kolom ligan.  

-  Grid-box disesuaikan dengan hasil validasi metode 

menggunakan Autodock Tools 

- Diberi nama sesuai ligan uji dan dicantumkan email.  

Preparasi ligan uji dan pembanding 

- Dilakukan optimasi menggunakan ChemDraw 

Professional 15.0® 

- File>Open>Gambar Struktur>Edit>Get 3D 

Model>Edit Chem 3D xml Object 

- Calculasion>MM2>Minimize 

Energy>Run>Save Copy As “ligan.pdb” 

- Dilakukan protonasi menggunakan Marvin 

Skecth® 

- File>Open>pilih ligan yang sudah 

dioptimasi> 

Simulasi Molecular Docking 

Hasil docking 

- Diunduh file dalam format (.rar)  

- Dianalisis nilai ∆G, interaksi ikatan kimia dan 

residu asam amino dengan visualisasi menggunakan 

Discovery studio visualizer®  
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LAMPIRAN 6 

SITUS DAN APLIKASI 

 

 

Gambar VII. 7 Tampilan situs PASS online 
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Gambar VII. 8 Tampilan situs Lipinski Rule of Five 

LAMPIRAN  6 

(LANJUTAN) 

 

 

Gambar VII. 9 Tampilan situs PreADMET 

 

 

Gambar VII. 10 Tampilan aplikasi Toxtree® 
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LAMPIRAN  6 

(LANJUTAN) 

 

 

Gambar VII. 11 Tampilan situs Protein Data Bank (PDB) 

 

 

Gambar VII. 12 Tampilan situs PubChem 
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LAMPIRAN  6 

(LANJUTAN) 

 

 

Gambar VII. 13 Tampilan aplikasi Discovery Studio Visualizer® 

 

Gambar VII. 14 Tampilan aplikasi ChemDraw Professional 15.0® 
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LAMPIRAN  6 

(LANJUTAN) 
 

 

Gambar VII. 15 Tampilan aplikasi AutoDock Tools® 

 

Gambar VII. 16 Tampilan aplikasi Notepad® 
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LAMPIRAN  6 

(LANJUTAN) 
 

 

Gambar VII. 17 Tampilan situs online SwissDock 

 

Gambar VII. 18 Tampilan aplikasi Marvin Sketch 
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LAMPIRAN 7 

STRUKTUR SENYAWA FLAVONOID 

Tabel VII. 2 

Struktur 2D dan 3D senyawa Flavonoid 

 

No. Flavonoid Struktur 2D Struktur 3D 

Flavon 

1. Apigenin 

 

 

 

 

2. Baicalein 

 

 

3. Chrysin 

 

 

4. Luteolin 

 

 

5. Scutelarein 
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LAMPIRAN 7 

(LANJUTAN) 

 

Tabel VII.2 

Lanjutan 

 

No. Flavonoid Struktur 2D Struktur 3D 

6. Hispidulin 

 

 

7. Chrysoeriol 

 

 

 

8. Tricetin 

 

 

9. Tangeretin 

 

 

10. Wogonin 

 

 

11. Rhoifolin 

 

 



79 

 

 

LAMPIRAN 7 

(LANJUTAN) 

 

Tabel VII.2 

Lanjutan 
 

No. Flavonoid Struktur 2D Struktur 3D 

12.  Diosmetin 

  

13. Acacetin 

 

 

14. Tricin 

 

 

Flavonol 

15. Galangin 

 

 

16. Fisetin 
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LAMPIRAN 7 

(LANJUTAN) 

 

Tabel VII.2 

Lanjutan 
 

No. Flavonoid Struktur 2D Struktur 3D 

17. Kaemferol 

 

 

18. Kaemferide 

 
 

19. Robinetin 

 

  

20. Herbasetin 

 

 

21. Quercetin 

 

 



81 

 

 

LAMPIRAN 7 

(LANJUTAN) 

 

Tabel VII.2 

Lanjutan 
 

No. Flavonoid Struktur 2D Struktur 3D 

22. Ramnetin 

 
 

 

23. Isoramnetin 

  

24 Myricetin 

 

 

25. Querstagenin 

 
  

26. Gossypetin 
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LAMPIRAN 7 

(LANJUTAN) 

 

Tabel VII.2 

Lanjutan 

 

No. Flavonoid Struktur 2D Struktur 3D 

27. Isoquercetin 

 

 

28. Ramnazin 

 

 

29. Rutin 

 

 
 

30. Morin 

 

 

31. Pachypodol 
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LAMPIRAN 7 

(LANJUTAN) 

 

Tabel VII.2 

Lanjutan 
 

No. Flavonoid Struktur 2D Struktur 3D 

Isoflavon 

32. Daidzein 

 

 

33. Formononetin 

 

 

34. Genistein 

 

 

35. Biokanin A 

 

 

36. Orobol 

 

 

37. Tectorigenin 
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LAMPIRAN 7 

(LANJUTAN) 

 

Tabel VII.2 

Lanjutan 

 

No Flavonoid Struktur 2D Struktur 3D 

38. Baptigenin 

 

 

Flavanon 

39. Pinocembrin 

 

 

40. Liquiritigenin 

 

 

41. Narigenin 
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LAMPIRAN 7 

(LANJUTAN) 

 

Tabel VII.2 

Lanjutan 
 

No. Flavonoid Struktur 2D Struktur 3D 

42. Sakuranetin 

 

 
 

43. Eriodictyol 

 

 

44. Hesperetin 

 

 

45. 
Homeriodicty

ol 
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Lanjutan 

 

No. Flavonoid Struktur 2D Struktur 3D 

46. Parietin 

 
 

 

47. 
Epigallocatechi

n 

 

 

48. Catechin 

 

 

49. Naringin 

 

 

Dehidroflavonol 

50. Pinobanskin 
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Tabel VII.2 

Lanjutan 
 

No. Flavonoid Struktur 2D Struktur 3D 

51. Aromadendrin 

 

 

52. Fustin 

 

 

53. Taksifolin 

 

 

BiFlavonoid 

54. 
Agathis-

flavone 
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Tabel VII.2 

Lanjutan 
 

No. Flavonoid Struktur 2D Struktur 3D 

55. 
Cupresu-

flavone 

 

 

56. Ginkgetin 

 

 

57. Sciadopitysin 

 

 

58. 
Robusta-

flavone 

 

 

59. 
Hinoki-

flavone 
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Lanjutan 
 

No. Flavonoid Struktur 2D Struktur 3D 

60. Ochnaflavone 

 

 

61. Amentoflavone 

 

 

Khalkon 

62. Isoliquiritigenin 

 

 

63. Khalkonarigenin 

 

 

64. Butein 
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(LANJUTAN) 

 

Tabel VII.2 

Lanjutan 

 

No. Flavonoid Struktur 2D Struktur 3D 

65. Okanin 

 

 

66. Phloretin 

 

 

67. Phlorizin 

 

 

Auron 

68. Sulfuretin 

 

  

69. Aureusidin 

 

 

70. Maritimetin 
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Tabel VII.2 

Lanjutan 
 

No. Flavonoid Struktur 2D Struktur 3D 

71. Leptosidin 

 

 

Antosianidin 

72. Apigenidin 

 
 

73. Luteolinnidin 

  

    

74. Pelargonidin 
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Tabel VII.2 

Lanjutan 
 

No. Flavonoid Struktur 2D Struktur 3D 

75. Cyanidin 

 
  

76. Peonidin 

 
 

77. Delpinidin 

 
 

78. Petunidin 

  

79. Malvinidin 
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Lanjutan 
 

No. Flavonoid Struktur 2D Struktur 3D 

80. Rosinidin 
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LAMPIRAN 8 

HASIL PENELITIAN PREDIKSI AKTIVITAS ANTIVIRUS 

Tabel VII. 3  

Hasil prediksi aktivitas antivirus menggunakan PASS online 

No. Falvonoid Pa Pi Aktivitas Antivirus 

Flavon 

1.         Apigenin 

0,469 0,007 Hepatitis B 

0,469 0,014 Herpes 

0,459 0,03 Influenza  

0,301 0,088 Adenovirus 

0,339 0,171 Picornavirus  

0,325 0,204 Rhinovirus 

0,229 0,112 CMV 

0,135 0,085 HIV 

0,195 0,167 Poxvirus 

2.         Baicalein 

0,49 0,005 Hepatitis B 

0,468 0,014 Herpes  

0,439 0,035 Influenza  

0,246 0,016 HIV 

0,308 0,083 Adenovirus 

0,355 0,153 Picornavirus 

0,232 0,106 CMV 

0,312 0,228 Rhinovirus 

0,202 0,156 Poxvirus 

0,112 0,082 Hepatitis 

0,082 0,01 Herpesvirus 3, Human 

3.         Chrysin 

0,468 0,007 Hepatitis B 

0,469 0,014 Herpes 

0,459 0,03 Influenza 

0,308 0,083 Adenovirus 

0,355 0,153 Picornavirus 

0,232 0,106 CMV  

0,312 0,228 Rhinovirus 

0,141 0,077 HIV 

0,202 0,156 Poxvirus 

0,011 0,01 Herpesvirus 3, Human 
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LAMPIRAN 8 

(LANJUTAN) 

 

Tabel VII.3 

Lanjutan 
 

No. Falvonoid Pa Pi Aktivitas Antivirus 

4. Luteolin 

0,473 0,006 Hepatitis B 

0,471 0,014 Herpes 

0,462 0,03 Influenza 

0,246 0,143 Adenovirus 

0,149 0,067 HIV 

0,215 0,142 CMV 

0,279 0,263 Picornavirus 

5.  Scutelarein 

0,487 0,005 Hepatitis B 

0,472 0,014 Herpes 

0,43 0,038 Influenza 

0,233 0,019 HIV 

0,273 0,114 Adenovirus 

0,308 0,214 Piconavirus 

0,216 0,14 CMV 

0,304 0,245 Rhinovirus 

0,11 0,085 Hepatitis 

6.  Hispidulin 

0,441 0,02 Herpes 

0,428 0,011 Hepatitis B 

0,331 0,072 Influenza 

0,314 0,225 Rhinovirus 

0,133 0,088 HIV 

0,221 0,177 Adenovirus 

0,198 0,19 CMV 

7. Chrysoeriol 

0,455 0,017 Herpes  

0,432 0,011 Hepatitis B 

0,427 0,038 Influenza 
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LAMPIRAN 8 

(LANJUTAN) 

 

Tabel VII.3 

Lanjutan 
 

No. Falvonoid Pa Pi Aktivitas Antivirus 

8. Tricetin 

0,24 0,151 Adenovirus 

0,216 0,141 CMV 

0,214 0,025 HIV 

0,499 0,005 Hepatitis B 

0,107 0,091 Hepatitis 

0,485 0,011 Herpes 

0,508 0,021 Influenza 

9. Tangeretin 

0,452 0,009 Hepatitis B 

0,363 0,053 Herpes 

0,316 0,221 Rhinovirus 

0,218 0,136 CMV 

0,22 0,169 Influenza  

10. Wogonin 

0,445 0,019 Herpes 

0,385 0,017 Hepatitis B 

0,358 0,061 Influenza 

0,126 0,102 HIV 

0,286 0,283 Rhinovirus 

11. Rhoifolin 

0,723 0,004 Influenza 

0,566 0,005 Herpes 

0,45 0,009 Hepatitis B 

0,142 0,02 Trachoma 

0,132 0,09 HIV 

12. Diosmetin 

0,455 0,017 Herpes 

0,432 0,011 Hepatitis B 

0,427 0,038 Influenza 
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LAMPIRAN 8 

(LANJUTAN) 

 

Tabel VII.3 

Lanjutan 
 

No. Falvonoid Pa Pi Aktivitas Antivirus 

13.  Acacetin 

0,452 0,018 Herpes 

0,417 0,013 Hepatitis B 

0,424 0,039 Influenza 

0,345 0,168 Rhinovirus 

0,233 0,16 Adenovirus 

0,211 0,152 CMV 

0,286 0,251 Piconavirus 

0,08 0,074 Trachoma 

14.  Tricin 

0,465 0,015 Herpes  

0,452 0,008 Hepatitis B 

0,457 0,031 Influenza 

0,14 0,077 HIV 

0,197 0,191 CMV 

Flavonol 

15.  Galangin 

0,496 0,005 Hepatitis B 

0,482 0,012 Herpes 

0,4 0,047 Influenza 

0,17 0,047 HIV 

0,253 0,136 Adenovirus 

0,293 0,24 Piconavirus 

0,206 0,166 CMV 

16.  Fisetin 

0,464 0,015 Herpes 

0,448 0,009 Hepatitis B 

0,322 0,076 Influenza 

0,18 0,041 HIV 

0,246 0,143 Adenovirus 

0,215 0,142 CMV 

0,279 0,263 Piconavirus 
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LAMPIRAN 8 

(LANJUTAN) 

 

Tabel VII.3 

Lanjutan 
 

No. Falvonoid Pa Pi Aktivitas Antivirus 

17.  Kaemferol 

0,496 0,005 Hepatitis B 

0,483 0,012 Herpes 

0,4 0,047 Influenza 

0,164 0,051 HIV 

0,246 0,143 Adenovirus 

0,203 0,174 CMV 

0,279 0,263 Piconavirus 

18.  Kaemferide 

0,465 0,015 Herpes 

0,457 0,008 Hepatitis B 

0,362 0,06 Influenza 

0,312 0,228 Rhinovirus  

0,128 0,097 HIV 

19. Robinetin 

0,472 0,014 Herpes 

0,461 0,008 Hepatitis B 

0,348 0,065 Influenza 

0,227 0,021 HIV 

0,22 0,178 Adenovirus 

0,203 0,176 CMV 

0,103 0,099 Hepatitis  

20. Herbacetin 

0,5 0,004 Hepatitis B 

0,476 0,013 Herpes 

0,414 0,042 Influenza 

0,273 0,114 Adenovirus 

0,185 0,037 HIV 

0,308 0,214 Picornavirus 

0,216 0,14 CMV 

0,104 0,098 Hepatitis  

21. Quercetin 

0,17 0,047 HIV 

0,498 0,005 Hepatitis B 

0,484 0,012 Herpes 

0,403 0,046 Influenza  
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LAMPIRAN 8 

(LANJUTAN) 

 

Tabel VII.3 

Lanjutan 

 

No. Falvonoid Pa Pi Aktivitas Antivirus 

22. Ramnetin 

0,463 0,007 Hepatitis B 

0,464 0,015 Herpes 

0,375 0,055 Influenza 

0,144 0,073 HIV 

0,296 0,261 Rhinovirus  

23. Isoramnetin 

0,465 0,007 Hepatitis B 

0,468 0,014 Herpes 

0,365 0,058 Influenza 

0,137 0,082 HIV 

24 Myricetin 

0,519 0,004 Hepatitis B 

0,5 0,01 Herpes 

0,444 0,034 Influenza 

0,234 0,019 HIV 

0,119 0,071 Hepatitis  

25. Querstagenin 

0,508 0,004 Hepatitis B 

0,48 0,012 Herpes 

0,369 0,057 Influenza 

0,244 0,017 HIV 

0,122 0,066 Hepatitis 

0,22 0,178 Adenovirus 

0,203 0,176 CMV 

26. Gossypetin 

0,498 0,005 Hepatitis B 

0,471 0,014 Herpes 

0,415 0,042 Influenza 

0,273 0,114 Adenovirus 

0,179 0,041 HIV 

0,229 0,113 CMV 

0,308 0,214 Picornavirus 

0,104 0,097 Hepatitis 
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LAMPIRAN 8 

(LANJUTAN) 

 

Tabel VII.3 

Lanjutan 

 

No. Falvonoid Pa Pi Aktivitas Antivirus 

27. Isoquercetin 

0,715 0,005 Influenza  

0,563 0,005 Herpes 

0,486 0,005 Hepatitis B 

0,171 0,047 HIV 

0,086 0,061 Tracoma 

0,102 0,102 Hepatitis 

28. Ramnazin 

0,455 0,008 Hepatitis B 

0,46 0,016 Herpes 

0,358 0,061 Influenza 

0,135 0,085 HIV 

29. Rutin 

0,743 0,004 Influenza  

0,526 0,007 Herpes 

0,451 0,009 Hepatitis B 

0,113 0,033 Tracoma 

0,13 0,094 HIV 

30. Morin 

0,486 0,011 Herpes 

0,48 0,005 Hepatitis B 

0,4 0,047 Influenza 

0,167 0,049 HIV 

0,246 0,143 Adenovirus 

0,203 0,174 CMV 

0,279 0,263 Picornavirus 

31. Pachypodol 

0,456 0,008 Hepatitis B 

0,44 0,021 Herpes 

0,358 0,061 Influenza 
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LAMPIRAN 8 

(LANJUTAN) 

 

Tabel VII.3 

Lanjutan 

 

No. Falvonoid Pa Pi Aktivitas Antivirus 

Isoflavon 

32. Daidzein 

0,407 0,032 Herpes 

0,417 0,097 Picornavirus 

0,304 0,086 Adenovirus 

0,296 0,092 Influenza 

0,228 0,064 Hepatitis B 

0,215 0,136 Poxvirus 

0,212 0,149 CMV 

0,084 0,065 Tracoma 

0,119 0,117 HIV 

33. Formononetin 

0,382 0,043 Herpes 

0,355 0,153 Picornavirus 

0,27 0,112 Influenza 

0,201 0,086 Hepatitis B 

0,312 0,228 Rhinovirus 

0,236 0,156 Adenovirus 

0,088 0,058 Tracoma 

34. Genistein 

0,43 0,024 Herpes 

0,349 0,023 Hepatitis B 

0,371 0,056 Influenza 

0,346 0,162 Picornavirus  

0,249 0,14 Adenovirus 

0,093 0,051 Trachoma 

0,108 0,089 Hepatitis 

35. Biokanin A 

0,41 0,031 Herpes 

0,3 0,033 Hepatitis B 

0,333 0,071 Influenza 

0,096 0,048 Trachoma 
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LAMPIRAN 8 

(LANJUTAN) 

 

Tabel VII.3 

Lanjutan 
 

No. Falvonoid Pa Pi Aktivitas Antivirus 

36. Orobol 

0,431 0,023 Herpes 

0,367 0,02 Hepatitis B 

0,374 0,055 Influenza 

0,285 0,252 Picornavirus  

0,128 0,099 HIV 

0,108 0,09 Hepatitis  

0,082 0,069 Tracoma 

37. Tectorigenin 

0,395 0,037 Herpes 

0,313 0,03 Hepatitis B 

0,262 0,12 Influenza 

0,078 0,077 Trachoma 

0,274 0,273 Picornavirus 

38. Baptigenin 

0,418 0,028 Herpes 

0,281 0,039 Hepatitis B 

0,32 0,077 Influenza 

0,173 0,045 HIV 

0,315 0,204 Picornavirus 

0,223 0,174 Adenovirus 

0,11 0,086 Hepatitis 

0,092 0,079 Hepatitis C 

Flavanon 

39. Pinocembrin 

0,691 0,006 Influenza  

0,608 0,005 Rhinovirus  

0,52 0,008 Herpes 

0,482 0,005 Hepatitis B 

0,314 0,205 Picornavirus 

0,231 0,163 Adenovirus 

0,112 0,082 Hepatitis 
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LAMPIRAN 8 

(LANJUTAN) 

 

Tabel VII.3 

Lanjutan 
 

No. Falvonoid Pa Pi Aktivitas Antivirus 

40. Liquiritigenin 

0,64 0,01 Influenza  

0,632 0,004 Rhinovirus  

0,498 0,01 Herpes 

0,427 0,012 Hepatitis B 

0,363 0,143 Picornavirus 

0,278 0,109 Adenovirus  

0,218 0,136 CMV 

0,203 0,155 Poxvirus 

0,102 0,101 Hepatitis 

41. Narigenin 

0,691 0,006 Influenza  

0,611 0,005 Rhinovirus  

0,499 0,01 Herpes 

0,483 0,005 Hepatitis B 

0,3 0,227 Picornavirus 

0,225 0,172 Adenovirus 

0,113 0,08 Hepatitis 

42. Sakuranetin 

0,691 0,006 Influenza  

0,611 0,005 Rhinovirus  

0,499 0,01 Herpes 

0,483 0,005 Hepatitis B 

0,3 0,227 Picornavirus 

0,225 0,172 Adenovirus 

0,113 0,08 Hepatitis 

43. Eriodictyol 

0,692 0,006 Influenza  

0,59 0,007 Rhinovirus  

0,523 0,007 Herpes 

0,485 0,005 Hepatitis B 

0,113 0,081 Hepatitis 

44. Hesperetin 

0,673 0,007 Influenza  

0,564 0,01 Rhinovirus  

0,503 0,009 Herpes 

0,455 0,008 Hepatitis B 
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LAMPIRAN 8 

(LANJUTAN) 

 

Tabel VII.3 

Lanjutan 
 

No. Falvonoid Pa Pi Aktivitas Antivirus 

45. Homeriodictyol 

0,673 0,007 Influenza  

0,564 0,01 Rhinovirus  

0,503 0,009 Herpes 

0,455 0,008 Hepatitis B 

46. Parietin 

0,412 0,03 Herpes 

0,401 0,046 Influenza 

0,366 0,045 Adenovirus 

0,235 0,059 Hepatitis B 

0,249 0,078 CMV 

0,144 0,019 Tracoma 

0,313 0,226 Rhinovirus 

0,205 0,151 Poxvirus 

47. Epigallocatechin 

0,712 0,005 Influenza  

0,514 0,02 Rhinovirus  

0,479 0,012 Herpes 

0,397 0,015 Hepatitis B 

0,352 0,005 HIV 

0,172 0,022 Hepatitis 

0,233 0,133 Influenza A 

0,102 0,058 Hepatitis C 

48. Catechin 

0,692 0,006 Influenza  

0,52 0,018 Rhinovirus  

0,465 0,015 Herpes 

0,352 0,022 Hepatitis B 

0,281 0,01 HIV 

0,234 0,13 Influenza A 

0,117 0,075 Hepatitis 

0,088 0,087 Hepatitis C 
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(LANJUTAN) 
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Lanjutan 
 

No. Falvonoid Pa Pi Aktivitas Antivirus 

49. Naringin 

0,817 0,003 Influenza 

0,667 0,003 Herpes 

0,462 0,007 Hepatitis B 

0,462 0,041 Rhinovirus 

0,123 0,027 Tracoma 

0,107 0,091 Hepatitis 

Dehidroflavonol 

50. Pinobanskin 

0,617 0,012 Influenza  

0,524 0,018 Rhinovirus  

0,49 0,011 Herpes 

0,384 0,017 Hepatitis B 

0,183 0,018 Hepatitis 

0,336 0,174 Picornavirus 

0,19 0,035 HIV 

0,202 0,155 Poxvirus 

0,204 0,204 Adenovirus 

51. Aromadendrin 

0,617 0,012 Influenza  

0,528 0,016 Rhinovirus  

0,491 0,011 Herpes 

0,386 0,017 Hepatitis B 

0,188 0,016 Hepatitis 

0,187 0,036 HIV 

0,322 0,194 Picornavirus 

0,196 0,166 Poxvirus 

52. Fustin 

0,528 0,016 Rhinovirus 

0,515 0,021 Influenza 

0,472 0,014 Herpes 

0,296 0,034 Hepatitis B 

0,206 0,028 HIV 

0,176 0,02 Hepatitis 

0,322 0,194 Picornavirus 

0,196 0,166 Poxvirus 
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(LANJUTAN) 

 

Tabel VII.3 

Lanjutan 
 

No. Falvonoid Pa Pi Aktivitas Antivirus 

53. Taksifolin 

0,62 0,011 Influenza 

0,492 0,01 Herpes  

0,503 0,023 Rhinovirus 

0,399 0,015 Hepatitis B 

0,142 0,075 HIV 

BiFlavonoid 

54. Agathisflavone 

0,491 0,011 Herpes 

0,47 0,006 Hepatitis B 

0,33 0,072 Influenza 

0,284 0,103 Adenovirus 

0,119 0,029 Tracoma 

0,118 0,072 Hepatitis 

0,129 0,096 HIV 

55. Cupresuflavone 

0,486 0,011 Herpes 

0,435 0,01 Hepatitis B 

0,433 0,037 Influenza 

0,296 0,092 Adenovirus 

0,094 0,05 Tracoma 

0,203 0,174 CMV 

0,127 0,099 HIV 

0,192 0,172 Poxvirus 

0,279 0,263 Picornavirus 

56. Ginkgetin 

0,431 0,024 Herpes 

0,368 0,02 Hepatitis B 

0,341 0,068 Influenza 

0,081 0,071 Tracoma 

57. Sciadopitisin 

0,469 0,014 Herpes 

0,369 0,019 Hepatitis B 

0,351 0,064 Influenza 

0,22 0,178 Adenovirus 

0,086 0,062 Tracoma 
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Lanjutan 
 

No. Falvonoid Pa Pi Aktivitas Antivirus 

58. Robustaflavone 

0,478 0,013 Herpes 

0,417 0,013 Hepatitis B 

0,355 0,062 Influenza 

0,28 0,107 Adenovirus 

0,087 0,06 Tracoma 

0,111 0,085 Hepatitis 

59. Hinokiflavone 

0,447 0,009 Hepatitis B 

0,446 0,019 Herpes 

0,311 0,082 Influenza 

0,168 0,049 HIV 

0,274 0,273 Picornavirus 

60. Ochnaflavone 

0,426 0,012 Hepatitis B 

0,436 0,022 Herpes 

0,351 0,064 Influenza 

0,126 0,101 HIV 

0,274 0,273 Picornavirus 

61. Amentoflavone 

0,49 0,011 Herpes 

0,438 0,01 Hepatitis B 

0,43 0,038 Influenza 

0,287 0,1 Adenovirus 

0,082 0,069 Tracoma 

Khalkon 

62. Isoliquiritigenin 

0,689 0,006 Influenza 

0,38 0,045 Herpes 

0,213 0,025 HIV 

0,261 0,127 Adenovirus 

0,232 0,134 Influenza A 

0,222 0,128 CMV 

0,302 0,224 Picornavirus 

0,126 0,061 Hepatitis 

0,11 0,047 Hepatitis C 

0,178 0,118 Hepatitis B 
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(LANJUTAN) 

 

Tabel VII.3 

Lanjutan 

 

No. Falvonoid Pa Pi Aktivitas Antivirus 

62. Isoliquiritigenin 
0,19 0,175 Poxvirus 

0,013 0,006 Herpesvirus 3, Human 

63. Khalkonarigenin 

0,689 0,006 Influenza 

0,38 0,045 Herpes 

0,213 0,025 HIV 

0,261 0,127 Adenovirus 

0,232 0,134 Influenza A 

0,222 0,128 CMV 

0,302 0,224 Picornavirus 

0,126 0,061 Hepatitis 

0,11 0,047 Hepatitis C 

0,178 0,118 Hepatitis B 

0,19 0,175 Poxvirus 

0,013 0,006 Herpesvirus 3, Human 

64. Butein 

0,695 0,005 Influenza 

0,386 0,042 Herpes 

0,237 0,018 HIV 

0,201 0,087 Hepatitis B 

0,211 0,152 CMV 

0,122 0,067 Hepatitis 

0,105 0,054 Hepatitis C 

0,209 0,194 Adenovirus 

0,208 0,198 Influenza A 

65. Okanin 

0,679 0,007 Influenza 

0,406 0,033 Herpes 

0,322 0,006 HIV 

0,246 0,053 Hepatitis B 

0,16 0,028 Hepatitis  

0,146 0,019 Hepatitis C 

0,224 0,122 CMV 

0,234 0,158 Adenovirus 

0,295 0,265 Rhinovirus 

0,21 0,193 Influenza A 
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  LAMPIRAN 8 

(LANJUTAN) 

 

Tabel VII.3 

Lanjutan 
  

No. Falvonoid Pa Pi Aktivitas Antivirus 

65. Okanin 0,011 0,009 Herpesvirus 3, Human 

66. Phloretin 

0,361 0,054 Herpes 

0,341 0,068 Influenza 

0,375 0,132 Piconavirus 

0,232 0,107 CMV 

0,165 0,051 HIV 

0,249 0,14 Adenovirus 

0,32 0,213 Rhinovirus 

0,193 0,17 Poxvirus 

67. Phlorizin 

0,658 0,009 Influenza 

0,451 0,018 Herpes 

0,344 0,024 Hepatitis B 

0,346 0,163 Piconavirus 

0,155 0,059 HIV 

0,223 0,155 Influenza A 

0,088 0,058 Tracoma 

0,103 0,099 Hepatitis 

Auron 

68. Sulfuretin 

0,343 0,064 Herpes 

0,301 0,088 Adenovirus 

0,18 0,115 Hepatitis B  

0,225 0,161 Influenza 

0,296 0,261 Rhinovirus 

0,128 0,098 HIV 

0,202 0,178 CMV 

69. Aureusidin 

0,388 0,041 Herpes 

0,296 0,034 Hepatitis B 

0,28 0,103 Influenza  

0,247 0,143 Adenovirus 

0,129 0,096 HIV 
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(LANJUTAN) 

 

Tabel VII.3 

Lanjutan 
 

No. Falvonoid Pa Pi Aktivitas Antivirus 

70. Maritimetin 

0,328 0,068 Adenovirus 

0,328 0,073 Herpes 

0,269 0,043 Hepatitis B 

0,144 0,073 HIV 

0,214 0,144 CMV 

71. Leptosidin 

0,25 0,051 Hepatitis B 

0,274 0,113 Adenovirus 

0,253 0,127 Herpes 

0,196 0,195 CMV 

Antosianidin 

72. Apigenidin (-) (-) (-) 

73. Luteolinnidin (-) (-) (-) 

74. Pelargonidin (-) (-) (-) 

75. Sianidin (-) (-) (-) 

76. Peonidin (-) (-) (-) 

77. Delpinidin (-) (-) (-) 

78. Petunidin (-) (-) (-) 

79. Malvinidin (-) (-) (-) 

80. Rosinidin (-) (-) (-) 
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LAMPIRAN 9 

HASIL PENELITIAN PREDIKSI DRUGLIKENESS 

Tabel VII. 4  

Hasil prediksi druglikeness menggunakan situs online lipinski’s rule of five 

No Ligan 
BM 

(Da) 

 Log 

P 

Donor 

Ikatan H 

Akseptor  

Ikatan H 
Ket.  

1 

N-(4-tert-

butylphenyl)-N-

[(1R)-2-

(methylamino)-2-

oxo-1-(pyridin-3-

yl)ethyl]propana

mide 

326 -0,13 0 5 Memenuhi 

2 
Hexylcarbamic 

acid 
145 1,83 2 3 Memenuhi 

3 

N-(2-

phenylethyl)meth

anesulfonamide 

199 0,63 1 3 Memenuhi 

4 
Lopinavir 

628 4,33 4 9 
Tidak 

Memenuhi 

5 
Remdesivir 

602 2,31 5 13 
Tidak 

Memenuhi 

6 Apigenin 270 2,42 3 5 Memenuhi 

7 Baicalein 270 2,42 3 5 Memenuhi 

8 Chrysin 254 2,71 2 4 Memenuhi 

9 Luteolin 386 2,13 4 6 Memenuhi 

10 Scutelarein 286 2,13 4 6 Memenuhi 

11 Hispidulin 300 2,43 3 6 Memenuhi 

12 Chrysoeriol 300 2,43 3 6 Memenuhi 

13 Tricetin 302 1,83 5 7 Memenuhi 

14 Tangeretin 372 2,91 0 7 Memenuhi 

15 Wogonin 284 2,72 2 5 Memenuhi 

16 
Rhoifolin 

578 -1,25 8 14 
Tidak 

Memenuhi 

17 Diosmetin 300 2,42 3 6 Memenuhi 

18 Acacetin 284 2,72 2 5 Memenuhi 

19 Tricin 330 2,44 3 7 Memenuhi 

20 Galangin 270 2,6 3 5 Memenuhi 

21 Fisetin 286 2,31 4 6 Memenuhi 
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LAMPIRAN 9 

(LANJUTAN) 

 

Tabel VII.4 

Lanjutan 
 

No Ligan 
BM 

(Da) 

 Log 

P 

Donor 

Ikatan H 

Akseptor  

Ikatan H 
Ket.  

22 Kaemferol 286 2,31 4 6 Memenuhi 

23 Kaemferide 300 2,61 3 6 Memenuhi 

24 Robinetin 302 2,01 5 7 Memenuhi 

25 Herbasetin 302 2,01 5 7 Memenuhi 

26 Quercetin 302 2,01 5 7 Memenuhi 

27 Ramnetin 316 2,31 4 7 Memenuhi 

28 Isoramnetin 316 2,31 4 7 Memenuhi 

29 Myricetin 318 1,72 6 8 Memenuhi 

30 Querstagenin 318 1,72 6 8 Memenuhi 

31 Gossypetin 318 1,72 6 8 Memenuhi 

32 
Isoquercetin 

464 -0,73 8 12 
Tidak 

Memenuhi 

33 Ramnazin 330 2,61 3 7 Memenuhi 

34 
Rutin 

610 -1,88 10 16 
Tidak 

Memenuhi 

35 Morin 302 2,01 5 7 Memenuhi 

36 Pachypodol 344 2,71 2 7 Memenuhi 

37 Daidzein 254 2,41 2 4 Memenuhi 

38 Formononetin 268 2,71 1 4 Memenuhi 

39 Genistein 270 2,11 3 5 Memenuhi 

40 Biokanin A 284 2,41 2 5 Memenuhi 

41 Orobol 286 1,82 4 6 Memenuhi 

42 Tectorigenin 300 2,42 3 6 Memenuhi 

43 Baptigenin 286 2,13 4 6 Memenuhi 

44 Pinocembrin 256 2,8 2 4 Memenuhi 

45 Liquiritigenin 256 2,8 2 4 Memenuhi 

46 Narigenin 272 2,51 3 5 Memenuhi 

47 Sakuranetin 286 2,81 2 5 Memenuhi 

48 Eriodictyol 288 2,21 4 6 Memenuhi 

49 Hesperetin 302 2,51 3 6 Memenuhi 

50 Homeriodictyol 302 2,51 3 6 Memenuhi 

51 Parietin 284 2,19 2 5 Memenuhi 
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(LANJUTAN) 

 

Tabel VII.4 

Lanjutan 

 

No Ligan 
BM 

(Da) 

 Log 

P 

Donor 

Ikatan H 

Akseptor  

Ikatan H 
Ket.  

52 
Epigallocatechin 

306 2,25 6 7 
Tidak 

Memenuhi 

53 Catechin 290 1,55 5 6 Memenuhi 

54 
Naringin 

580 -1,16 8 14 
Tidak 

Memenuhi 

55 Pinobanskin 272 1,77 3 5 Memenuhi 

56 Aromadendrin 288 1,48 4 6 Memenuhi 

57 Fustin 288 1,48 4 6 Memenuhi 

58 Taksifolin 304 1,18 5 7 Memenuhi 

59 
Agathisflavone 

538 4,81 6 10 
Tidak 

Memenuhi 

60 
Cupresuflavone 

538 4,81 6 10 
Tidak 

Memenuhi 

61 
Ginkgetin 

566 5,42 4 10 
Tidak 

Memenuhi 

62 
Siadopitisin 

580 5,73 3 10 
Tidak 

Memenuhi 

63 
Robustaflavone 

538 4,81 6 10 
Tidak 

Memenuhi 

64 
Hinokiflavone 

538 5,24 5 10 
Tidak 

Memenuhi 

65 
Ochnaflavone 

358 5,24 5 10 
Tidak 

Memenuhi 

66 
Amentoflavone 

538 4,8 6 10 
Tidak 

Memenuhi 

67 Isoliquiritigenin 256 2,7 3 4  Memenuhi 

68 Khalkonarigenin 272 2,41 4 5  Memenuhi 

69 Butein 272 2,41 4 5 Memenuhi 

70 Okanin 288 2,11 5 6 Memenuhi 

71 Phloretin 274 2,32 4 5 Memenuhi 

72 
Phlorizin 

436 -0,2 7 10 
Tidak 

Memenuhi 

73 Sulfuretin 270 2,42 3 5 Memenuhi 

74 Aureusidin 286 2,13 4 6 Memenuhi 

75 Maritimetin 286 2,13 4 6 Memenuhi 
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Tabel VII.4 

Lanjutan 

 

No Ligan 
BM 

(Da) 

 Log 

P 

Donor 

Ikatan H 

Akseptor  

Ikatan H 
Ket.  

76 Leptosidin 300 2,43 3 6 Memenuhi 

77 Apigenidin 290 2,68 3 4 Memenuhi 

78 Luteolinnidin 271 3,2 4 5 Memenuhi 

79 Pelargonidin 271 3,2 4 5 Memenuhi 

80 Cyanidin 287 2,9 5 6 Memenuhi 

81 Peonidin 301 3,2 4 6 Memenuhi 

82 
Delpinidin 

338 2,32 6 7 
Tidak 

Memenuhi 

83 Petunidin 317 2,9 5 7 Memenuhi 

84 Malvinidin 366 2,93 4 7 Memenuhi 

85 Rosinidin 315 2,23 3 6 Memenuhi 
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LAMPIRAN 10 

HASIL PENELITIAN PREDIKSI FARMAKOKINETIKA 

Tabel VII. 5  
Hasil prediksi farmakokinetika menggunakan situs online Pre-ADMET 

No. Ligan 

Absorbsi Distribusi 

HIA 

(%) 

CaCo-2 

Cell (nm 

sec) 

Plasma 

Protein 

Binding 

(%) 

1 

N-(4-tert-butylphenyl)-N-[(1R)-2-

(methylamino)-2-oxo-1-(pyridin-3-

yl)ethyl]propanamide 
97,64* 22,44** 87,14** 

2 Hexylcarbamic acid 85,33* 11,08** 73,92** 

3 N-(2-phenylethyl)methanesulfonamide 94,47* 7,83** 58,35** 

4 Lopinavir 93,80* 24,06** 89,71** 

5 Remdesivir 38,21 2,89 74,45 

6 Apigenin 88,12* 10,54** 97,25* 

7 Baicalein 88,11* 1,28*** 98,98* 

8 Chrysin 92,13* 2,48*** 95,09 * 

9 Luteolin 79,43* 4,54** 99,72 * 

10 Scutelarein 77,42* 4.53** 100 * 

11 Hispidulin 93,21* 3,53*** 91,80 * 

12 Chrysoeriol 88,18* 5,18** 90,87 * 

13 Tricetin 63,47** 1,48*** 100 * 

14 Tangeretin 98,88* 53,60*** 87,17 ** 

15 Wogonin 93,04* 4,28** 90,45 * 

16 Rhoifolin 20,17** 9,92** 54,72** 

17 Diosmetin 88,18* 7,02** 90,160 * 

18 Acacetin 93.04* 12,79** 90,91* 

19 Tricin 87.82* 3*** 87,66** 

20 Galangin 88,12* 3,71*** 88,12 ** 

21 Fisetin 79,43* 9,57** 88,73 ** 

22 Kaemferol 79,61* 9,58** 89,61 ** 

23 Kaemferide 88,192* 9,33** 83,99 ** 

24 Robinetin 63,47** 3,41*** 92,63 * 

25 Herbasetin 63,47** 5,32** 93,07 *  

26 Quercetin 63,49** 3,41*** 93,24 * 
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LAMPIRAN 10 

(LANJUTAN) 

 
Tabel VII.5 

Lanjutan 

 

No. Ligan 

Absorbsi Distribusi 

HIA (%) CaCo-2 Cell (nm sec) 

Plasma 

Protein 

Binding 

(%) 

27 Ramnetin 78,34* 4,93** 85,35 ** 

28 Isoramnetin 78,35* 4,94** 83,55 ** 

29 Myricetin 40,96** 0,99*** 96,78 * 

30 Querstagenin 40,95** 0,99*** 98,34 * 

31 Gossypetin 65,62** 5,02** 92,67 * 

32 Isoquercetin 16.55*** 11,96** 65,76** 

33 Ramnazin 87,21* 5,09** 81,21 ** 

34 Rutin 2,86*** 7,91** 43,89** 

35 Morin 63,49** 17,10** 91,63 * 

36 Pachypodol 93,45* 4,38** 79,88 ** 

37 Daidzein 92,65* 7,72** 88,70 ** 

38 Formononetin 93,02* 21,21** 86,72 ** 

39 Genistein 88,12* 5,75** 89,74 ** 

40 Biokanin A 93,04* 3,41*** 85,01 ** 

41 Orobol 79,42* 11,29** 90,31 * 

42 Tectorigenin 93,04* 7,06** 89,44 ** 

43 Baptigenin 79,41* 1,56*** 90,35 * 

44 Pinocembrin 92,35* 2,47*** 98,45 * 

45 Liquiritigenin 92,35* 17,65** 97,99 * 

46 Narigenin 87,31* 10,52** 100 * 

47 Sakuranetin 92.75* 12,82** 95,75 * 

48 Eriodictyol 77,47* 4,53** 100 * 

49 Hesperetin 87,19* 7,00** 96,79 * 

50 Homeriodictyol 87,19* 5,16** 98,92 * 

51 Parietin 94,04* 20,74** 95,21 * 

52 Epigallocatechin 45,95** 0,37*** 100* 

53 Catechin 66,70** 0,65*** 100 * 

54 Naringin 15,46*** 16,35** 69,33** 
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LAMPIRAN 10 

(LANJUTAN) 

 
Tabel VII.5 

Lanjutan 

 

No. Ligan 

Absorbsi Distribusi 

HIA (%) CaCo-2 Cell (nm sec) 

Plasma 

Protein 

Binding 

(%) 

55 Pinobanskin 87,60* 3,69*** 86,64 ** 

56 Aromadendrin 77,83* 9,56** 98,67 * 

57 Fustin 77,82* 9,56** 88,03 ** 

58 Taksifolin 60,16** 3,42*** 95,16 * 

59 Agathisflavone 79,96* 11,09 100* 

60 Cupresuflavone 81,19* 0,36*** 100* 

61 Ginkgetin 91,11* 11,98** 95,06* 

62 Siadopitisin 94,05* 13,68** 90,51* 

63 Robustaflavone 81,19* 12,04** 100* 

64 Hinokiflavone 86,95* 4,34** 100* 

65 Ochnaflavone 91,62* 8,94** 100* 

66 Amentoflavone 81,19* 12,87** 100* 

67 Isoliquiritigenin 88,30* 20,16** 98,25 * 

68 Khalkonarigenin 80,61* 18,10** 100 * 

69 Butein 97,80* 56,04** 88,98 ** 

70 Okanin 66,57** 14,31** 100 * 

71 Phloretin 78,98* 18,1** 100* 

72 Phlorizin 24,33** 17,98** 77,79** 

73 Sulfuretin 88,85* 20,02** 97,24 * 

74 Aureusidin 82,57* 8,15** 100 * 

75 Maritimetin 92,56* 8,15** 100 * 

76 Leptosidin 89,73* 9,81** 98,09 * 

77 Apigenidin  (-)  (-)    (-) 

78 Luteolinnidin 83,57* 0,68*** 100* 

79 Pelargonidin 83,58* 1,29*** 100* 

80 Cyanidin 72,5* 0,65*** 100* 

81 Peonidin 83,43* 1,65*** 100* 

82 Delpinidin   (-)  (-)    (-) 

83 Petunidin 71,31* 0,96*** 100* 



118 

 

 

LAMPIRAN 10 

(LANJUTAN) 

 
Tabel VII.5 

Lanjutan  
 

No. Ligan 

Absorbsi Distribusi 

HIA (%) CaCo-2 Cell (nm sec) 

Plasma 

Protein 

Binding 

(%) 

84 Malvinidin   (-)  (-)   (-)  

85 Rosinidin 90,13* 2,12*** 87,78** 

 

 

HIA (%):  

 *: 70-100 terserap baik 

  ** :20-70 terserap cukup 

 *** :<20 kurang terserap 

CaCo-2 (nm sec): 

 * :>70 permeabilitas tinggi  

  ** :4-70 permeabilitas sedang  

  
***: <4 permeabilitas rendah 

PPB (%):  

 *: >90 terikat kuat 

 **: <90 terikat lemah  
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LAMPIRAN 11 

HASIL PENELITIAN PREDIKSI TOKSISITAS 

Tabel VII. 6  
Hasil prediksi toksisitas menggunakan aplikasi Toxtree® 

No Ligan 

Mutagen 

(Amest 

Test) 

Karsinogenik 
Kroes 

TTC Genotoxic 
Non 

Genotoxic 

1 

N-(4-tert-

butylphenyl)-N-[(1R)-

2-(methylamino)-2-

oxo-1-(pyridin-3-

yl)ethyl]propanamide 

(-) (-) (-) 
Tidak 

Beresiko 

2 
Hexylcarbamic acid 

(-) (-) (-) 
Tidak 

Beresiko 

3 

N-(2-

phenylethyl)methanes

ulfonamide 

(-) (-) (-) 
Tidak 

Beresiko 

4 
Lopinavir 

(-) (-) (-) 
Tidak 

Beresiko 

5 Remdesivir (+) (+) (+) Bersiko  

6 
Apigenin 

(-) (-) (-) 
Tidak 

Beresiko 

7 
Baicalein 

(-) (-) (-) 
Tidak 

Beresiko 

8 
Chrysin 

(-) (-) (-) 
Tidak 

Beresiko 

9 
Luteolin 

(-) (-) (-) 
Tidak 

Beresiko 

10 
Scutelarein 

(-) (-) (-) 
Tidak 

Beresiko 

11 
Hispidulin 

(-) (-) (-) 
Tidak 

Beresiko 

12 
Chrysoeriol 

(-) (-) (-) 
Tidak 

Beresiko 

13 
Tricetin 

(-) (-) (-) 
Tidak 

Beresiko 

14 
Tangeretin 

(-) (-) (-) 
Tidak 

Beresiko 

15 
Wogonin 

(-) (-) (-) 
Tidak 

Beresiko 
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(LANJUTAN) 

 

Tabel VII.6 

Lanjutan 

 

No Ligan 

Mutagen 

(Amest 

Test) 

Karsinogenik 
Kroes 

TTC Genotoxic 
Non 

Genotoxic 

16 
Rhoifolin 

(-) (-) (-) 
Tidak 

Beresiko 

17 
Diosmetin 

(-) (-) (-) 
Tidak 

Beresiko 

18 
Acacetin 

(-) (-) (-) 
 Tidak 

Beresiko 

19 
Tricin 

(-) (-) (-) 
 Tidak 

Beresiko 

20 
Galangin 

(-) (-) (-) 
Tidak 

Beresiko 

21 
Fisetin 

(-) (-) (-) 
Tidak 

Beresiko 

22 
Kaemferol 

(-) (-) (-) 
Tidak 

Beresiko 

23 
Kaemferide 

(-) (-) (-) 
Tidak 

Beresiko 

24 
Robinetin 

(-) (-) (-) 
Tidak 

Beresiko 

25 
Herbasetin 

(-) (-) (-) 
Tidak 

Beresiko 

26 
Quercetin 

(-) (-) (-) 
Tidak 

Beresiko 

27 
Ramnetin 

(+) (-) (-) 
Tidak 

Beresiko 

28 
Isoramnetin 

(+) (-) (-) 
Tidak 

Beresiko 

29 
Myricetin 

(+) (-) (-) 
Tidak 

Beresiko 

30 
Querstagenin 

(+) (-) (-) 
Tidak 

Beresiko 

31 
Gossypetin 

(+) (-) (-) 
Tidak 

Beresiko 

32 
Isoquercetin 

(+) (-) (-) 
Tidak 

Beresiko 
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LAMPIRAN 11 

(LANJUTAN) 

 

Tabel VII.6 

Lanjutan 

 

No Ligan 

Mutagen 

(Amest 

Test) 

Karsinogenik 
Kroes 

TTC Genotoxic 
Non 

Genotoxic 

33 
Ramnazin 

(+) (-) (-) 
Tidak 

Beresiko 

34 
Rutin 

(-) (-) (-) 
Tidak 

Beresiko 

35 
Morin 

(-) (-) (-) 
Tidak 

Beresiko 

36 
Pachypodol 

(+) (-) (-) 
Tidak 

Beresiko 

37 
Daidzein 

(-) (-) (-) 
Tidak 

Beresiko 

38 
Formononetin 

(-) (-) (-) 
Tidak 

Beresiko 

39 
Genistein 

(-) (-) (-) 
Tidak 

Beresiko 

40 
Biokanin A 

(-) (-) (-) 
Tidak 

Beresiko 

41 
Orobol 

(-) (-) (-) 
Tidak 

Beresiko 

42 
Tectorigenin 

(-) (-) (-) 
Tidak 

Beresiko 

43 
Baptigenin 

(-) (-) (-) 
Tidak 

Beresiko 

44 
Pinocembrin 

(-) (-) (-) 
Tidak 

Beresiko 

45 
Liquiritigenin 

(-) (-) (-) 
Tidak 

Beresiko 

46 
Narigenin 

(-) (-) (-) 
Tidak 

Beresiko 

47 
Sakuranetin 

(-) (-) (-) 
Tidak 

Beresiko 

48 
Eriodictyol 

(-) (-) (-) 
Tidak 

Beresiko 

49 
Hesperetin 

(-) (-) (-) 
Tidak 

Beresiko 
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LAMPIRAN 11 

(LANJUTAN) 

 

Tabel VII.6 

Lanjutan 

 

No Ligan 

Mutagen 

(Amest 

Test) 

Karsinogenik 
Kroes 

TTC Genotoxic 
Non 

Genotoxic 

50 
Homeriodictyol 

(-) (-) (-) 
Tidak 

Beresiko 

51 
Parietin 

(+) (+) (-) 
Beresiko 

Rendah 

52 
Epigallocatechin 

(-) (-) (-) 
Tidak 

Beresiko 

53 
Catechin 

(-) (-) (-) 
Tidak 

Beresiko 

54 
Naringin 

(-) (-) (-) 
Tidak 

Beresiko 

55 
Pinobanskin 

(-) (-) (-) 
Tidak 

Beresiko 

56 
Aromadendrin 

(-) (-) (-) 
Tidak 

Beresiko 

57 
Fustin 

(-) (-) (-) 
Tidak 

Beresiko 

58 
Taksifolin 

(-) (-) (-) 
Tidak 

Beresiko 

59 
Agathisflavone 

(-) (-) (+) 
Tidak 

Beresiko 

60 
Cupresuflavone 

(-) (-) (+) 
Tidak 

Beresiko 

61 
Ginkgetin 

(-) (-) (+) 
Tidak 

Beresiko 

62 
Siadopitisin 

(-) (-) (+) 
Tidak 

Beresiko 

63 
Robustaflavone 

(-) (-) (+) 
Tidak 

Beresiko 

64 
Hinokiflavone 

(-) (-) (-) 
Tidak 

Beresiko 

65 
Ochnaflavone 

(-) (-) (-) 
Tidak 

Beresiko 

66 
Amentoflavone 

(-) (-) (+) 
Tidak 

Beresiko 
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(LANJUTAN) 

 

Tabel VII.6 

Lanjutan 

 

No Ligan 

Mutagen 

(Amest 

Test) 

Karsinogenik 
Kroes 

TTC Genotoxic 
Non 

Genotoxic 

 67 
Isoliquiritigenin 

(+) (+) (-) 
Beresiko 

Rendah 

68 
Khalkonarigenin 

(+) (+) (-) 
Beresiko 

Rendah 

69 
Butein 

(+) (+) (-) 
Beresiko 

Rendah 

70 
Okanin 

(+) (+) (-) 
Beresiko 

Rendah 

71 
Phloretin 

(-) (-) (-) 
Tidak 

Beresiko 

72 
Phlorizin 

(-) (-) (-) 
Tidak 

Beresiko 

73 
Sulfuretin 

(-) (-) (-) 
Tidak 

Beresiko 

74 
Aureusidin 

(-) (-) (-) 
Tidak 

Beresiko 

75 
Maritimetin 

(-) (-) (-) 
Tidak 

Beresiko 

76 
Leptosidin 

(-) (-) (-) 
Tidak 

Beresiko 

77 
Apigenidin 

(-) (-) (-) 
Tidak 

Beresiko 

78 
Luteolinnidin 

(-) (-) (-) 
Tidak 

Beresiko 

79 
Pelargonidin 

(-) (-) (-) 
Tidak 

Beresiko 

80 
Cyanidin 

(-) (-) (-) 
Tidak 

Beresiko 

81 
Peonidin 

(-) (-) (-) 
Tidak 

Beresiko 

82 
Delpinidin 

(-) (-) (-) 
Tidak 

Beresiko 

83 
Petunidin 

(-) (-) (-) 
Tidak 

Beresiko 
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Tabel VII.6 

Lanjutan 

 

No Ligan 

Mutagen 

(Amest 

Test) 

Karsinogenik 
Kroes 

TTC Genotoxic 
Non 

Genotoxic 

84 
Malvinidin 

(-) (-) (-) 
Tidak 

Beresiko 

85 
Rosinidin 

(-) (-) (-) 
Tidak 

Beresiko 
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LAMPIRAN 12 

HASIL PENELITIAN SIMULASI MOLECULAR DOCKING 

Tabel VII. 7  
Hasil penambatan senyawa Flavonoid pada reseptor SARS-COV-2 ID PDB 5RL4 

No. Ligan ∆G 

(kkal/mol) 

Residu Asam Amino 

1 

N-(4-tert-butylphenyl)-N-

[(1R)-2-(methylamino)-

2-oxo-1-(pyridin-3-

yl)ethyl]propanamide 

-8,47 MET 49,  ASN 142, CYS 145 

2 
Lopinavir 

-10,86 
MET 49,  MET 165, ASN 142, 

CYS 145, GLU 166 

3 

Remdesivir 

-10,39 

MET 49, ASN 142, CYS 145, 

ARG 188, GLY 143, PRO 168, 

THR 26, THR 25 

4 
Apigenin 

-7,31 
MET 49 MET 165, CYS 145, 

ASN 142, GLY 148, GLN 189 

5 
Baicalein 

-7,26 
MET 49, MET 165, CYS 145, 

GLY 143, GLN 189 

6 
Chrysin 

-7,23 
MET 49, MET 165, CYS 44, 

CYS 145, GLU 166, GLY 148 

7 

Luteolin 

-7,33 

MET 49, MET 165, CYS 145, 

GLY 143, GLN 189, GLY 143, 

THR 190 

8 
Scutelarein 

-7,39 
MET 49, MET 165, CYS 145, 

GLY 143, GLN 189 

9 
Hispidulin 

-7,72 
MET 165, CYS 145, GLY 143, 

GLN 189 

10 

Chrysoeriol 

-7,59 

MET 165, CYS 145, ASN 

142,GLU 166, GLY 143, GLN 

189 

11 

Tricetin 

-7,55 

MET 165, CYS 145, ASN 142, 

GLY 143, GLN 189, ARG 188, 

THR 190 

12 

Tangeretin 

-8,57 

MET 49, MET 165, GLU 166, 

ASN 187, GLU 166, LEU 141, 

PHE 140 
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(LANJUTAN) 

 
Tabel VII.7 

Lanjutan 

 

No. Ligan ∆G (kkal/mol) Residu Asam Amino 

13 Wogonin -7,69 
MET 165, CYS 145, ASN 142, GLY 143, 

GLN 189 

14 Rhoifolin -9,34 
MET 49, CYS 44, GLU 166, GLY 143, 

THR 25 

15 Diosmetin -7,79 
MET 49, MET 165, GLN 189, GLY 143, 

THR 190, ARG 188 

16 Acacetin -7,75 
MET 49, MET 165, CYS 145, GLY 143, 

GLN 189, THR 190, ARG 188 

17 Tricin -8 
MET 165, CYS 145, ASN 142 GLY 143, 

GLN 189, GLY 148, THR 190 

18 Galangin -7,4 
MET 49, MET 165, CYS 145, ASN 142, 

GLY 148 

19 Fisetin -7,38 
MET 49, MET 165, CYS 145, GLU 166, 

GLY 148, GLN 189, ARG 188 

20 Kaemferol -7,45 
MET 49 MET 165, CYS 145, GLU 166, 

GLY 143, GLN 189 

21 Kaemferide -7,87 
MET 49, MET 165, CYS 145, GLY 143, 

GLN 189, THR 190, ARG 188 

22 Robinetin -7,54 
MET 165, CYS 145, ASN 142, GLY 143, 

GLN 189, ARG 188, THR 190 

23 Herbasetin -7,47 MET 165, CYS 145, GLY 143, GLN 189 

24 Quercetin -7,45 
MET 49, CYS 44, GLU 166, GLY 143, 

GLN 189, ARG 188 

25 Ramnetin -8,01 
MET 49, CYS 44, CYS 145, GLU 166, 

GLY 143, ASP 187, LEU 141 

26 Isoramnetin -7,7 MET 49, MET 165, CYS 145, GLY 143, 

GLN 189 

27 Myricetin -7,58 MET 165, CYS 145, ASN 142, GLY 143, 

GLN 189, THR 190, ARG 188 

28 Querstagenin -7,49 MET49, MET 165, CYS 145, ASN 142, 

GLY 143, GLN 189,  THR 190 

29 Gossypetin -7,49 MET 49, MET 165, CYS 145, GLY 143, 

GLN 189 

30 Isoquercetin -8,92 PRO 168, GLU 166 

31 Ramnazin -8,24 MET 49, CYS 145, GLY 148, ASP 187 
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Tabel VII.7 

Lanjutan 

 

No. Ligan ∆G (kkal/mol) Residu Asam Amino 

32 Rutin -9,57 GLU 166, GLN 189, PH3 140, THR 

26, PRO 168, HSD 41 

33 Morin -7,23 MET 165, GLY 148 

34 Pachypodol -8,38 MET 49, CYS 44, CYS 145, GLU 

166, GLY 143, ARG 188, HSD 41 

35 Daidzein -7,4 MET 165, CYS 145, GLY 143, GLN 

189, THR 190 

36 Formononetin -7,72 MET 165, CYS 145, GLU 166, GLY 

143, GLN 189, THR 190 

37 Genistein -7,34 MET 165, CYS 145, GLU 166, GLY 

143, GLN 189, THR 190 

38 Biokanin A -7,69 MET 165, CYS 145, GLU 166, GLY 

143, GLN 189, THR 190 

39 Orobol -7,42 MET 165, CYS 145, GLU 166, GLY 

143, GLN 189, THR 190 

40 Tectorigenin -7,52 MET 165, CYS 145, GLY 143, GLN 

189 

41 Baptigenin -7,54 MET 165, CYS 145, GLU 166, GLY 

143, GLN 189, THR 190, ARG 188 

42 Pinocembrin -7,27 MET ASN 142, GLU 166, ARG 188 

43 Liquiritigenin -7,25 MET 49, MET 165, GLU 166, GLN 

189, ARG 188 

44 Narigenin -7,39 MET 49, CYS 143, THR 26 

45 Sakuranetin -7,71 MET 49, ASN 142, GLU 166, PHE 

140 

46 Eriodictyol -7,61 MET 49, ASN 142, GLU 166, PHE 

140 

47 Hesperetin -7,65 
MET 49, CYS 44, GLU 166, PHE 

140, HSD 41 

48 Homeriodictyol -7,81 MET 49, GLU 166, ASN 142 

49 Parietin -7,6 
MET 49, CYS 145, GLY 148, GLU 

166, LEU 141 

50 Epigallocatechin -7,72 MET 49, GLU 166, ASN 142 

51 Catechin -7,66 MET 49, GLU 166 

52 Naringin -10,13 
MET 49, GLU 166, ASN 142, PHE 

140, THR 24 
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Tabel VII.7 

Lanjutan 
 

No. Ligan ∆G (kkal/mol) Residu Asam Amino 

53 Pinobanskin -7,36 MET 49, GLU 166, ASN 142 

54 Aromadendrin -7,43 MET 49, GLU 166, ASN 142, PHE 140 

55 Fustin -7,4 MET 49, GLU 166, ASN 142, PHE 140 

56 Taksifolin -7,67 MET 49, GLU 166 

57 Agathisflavone -7,71 MET 165, GLN 189, PRO 168, SER 46 

58 Cupresuflavone -8,42 
GLN 192, PRO 184, ARG 188, ALA 191, 
VAL 186 

59 Ginkgetin -9,13 
MET 49,  MET 165, ASN 142, CYS 145, 
GLU 166, GLY 143, GLN 189, PRO 168, 
LEU 141 

60 Siadopitisin -9,51 
MET 165, CYS 145, GLN 189, ASN 142, 
THR 190, PRO 168 

61 Robustaflavone -8,02 
MET 49,  MET 165, ASN 142, CYS 145, 
GLY 143, GLN 189, THR 190, THR 25 

62 Hinokiflavone -8,51 
MET 165, GLN 189, GLY 143, GLU 166, 
THE 190, TH4 25, THR 26, PRO 186 

63 Ochnaflavone -9,66 MET 49, MET 165, CYS 44, CYS 145, GLU 
166, GLY 148, ASN 142, THR 26, PRO 168 

64 Amentoflavone -8,98 MET 49, MET 165, CYS 145, GLN 189, 
PRO 168 

65 Isoliquiritigenin -7,82 CYS 145, ASN 142, GLU 166, GLY 143, 
PHE 140, THR 26 

66 Khalkonarigenin -7,44 ASN 142, GLU 166, GLY 143 

67 Butein -7,66 MET 49, CYS 44, CYS 145, ASN 142, GLY 
143 

68 Okanin -7,51 MET 49, MET 165, GLN 189 

69 Phloretin -7,76 MET 49, MET 165, GLU 166, ASN 142, 
GLN 189, HSE 164 

70 Phlorizin -9,12 MET 165, ASN 142, GLU 166, GLN 189 

71 Sulfuretin -7,71 CYS 145, ASN 142, GLU 166, PHE 140 

72 Aureusidin -7,75 MET 165, ASN 142, GLU 166, PHE 140 

73 Maritimetin -7,8 MET 49, GLU 166, LEU 141 

74 Leptosidin -8,03 MET 49, ASN 142, GLU 166, PHE 140 
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Tabel VII. 8  
Hasil penambatan senyawa Flavonoid pada reseptor SARS-COV-2 ID PDB 5R7Y 

No. Ligan ∆G 

(kkal/mol) 

Residu Asam Amino 

1 N-(2-phenylethyl) 

methanesulfonamide 

-6,91 MET 165, GLU 166, GLN 189, 

LEU 167, THR 190 

2 Lopinavir -9,79 MET 49, GLU 166, GLN 189, 

ASN 142, HSE 164, PRO 168 

3 Remdesivir -9,95 MET 49, GLU 166, GLN 189, 

ASN 142, HSE 164, PHE 140, 

SER 46, HSE 41 

4 Apigenin -6,65 MET 165, GLU 166, CYS 145, 

THR 190, ARG 188, PRO 168 

5 Baicalein -6,82 MET 165, GLU 166, GLN 189, 

THR 190, PRO 168 

6 Chrysin -6,72 MET 165, GLU 166, GLN 189, 

THR 190, PRO 168 

7 Luteolin -7,04 PRO 168, THR 190 

8 Scutelarein -6,85 MET 165, GLN 189, THR 190, 

PRO 168, HSE 41 

9 Hispidulin -6,8 MET 165, GLU 166, CYS 145, 

THR 190, PRO 168 

10 Chrysoeriol -7,11 MET 165, GLN 189, THR 190, 

PRO 168, HSE 41 

11 Tricetin -7,11 MET 165, GLN 189, THR 190, 

PRO 168, HSE 41 

12 Tangeretin -8,25 GLN 189, THR 190, PRO 186, 

LEU 141 

13 Wogonin -7,03 MET 165, THR 190, PRO 168 

14 Rhoifolin -8,58 MET 49, MET 165, THR 24, 

HSE 44 

15 Diosmetin -7,33 MET 165, GLN 189, THR 190, 

PRO 168, HSE 41 

16 Acacetin -6,99 MET 165, GLU 166, THR 190, 

PRO 168 

17 Tricin -7,29 MET 165, GLU 166, CYS 145, 

PRO 168, ARG 188 
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Tabel VII.8 

Lanjutan 

 

No. Ligan ∆G  

(kkal/mol) 

Residu Asam Amino 

18 Galangin -6,64 MET 165, THR 190, PRO 168, ARG 

188 

19 Fisetin -6,84 MET 49, CYS 145, GLU 166 

20 Kaemferol -6,7 MET 49, THR 190, PRO 168, ARG 

188, HSE 41 

21 Kaemferide -7,06 MET 165, GLU 166, THR 190, PRO 

168, LEU 141 

22 Robinetin -6,85 MET 49, CYS 145,  HSE 41 

23 Herbasetin -6,78 MET 49, MET 165, THR 190, HSE 

41, PRO 168 

24 Quercetin -6,89 CYS 145, GLU 166, PHE 140 

25 Ramnetin -7,08 MET 165, PRO 168, THR 190, LEU 

176 

26 Isoramnetin -7,01 MET 165, CYS 145, THR 190, PRO 

168, ARG 188, HSE 41 

27 Myricetin -7,14 MET 49, CYS 44, HSE 41, SER 46 

28 Querstagenin -7,06 MET 49, THR 190, PRO 168, ARG 

188, HSE 41 

29 Gossypetin -7,06 MET 49, THR 190, PRO 168, ARG 

188, HSE 41 

30 Isoquercetin -8,78 CYS 44, GLU 166, PHE 140, HSE 41 

31 Ramnazin -7,29 MET 49, MET 165, ASN 142, ARG 

188 

32 Rutin -8,85 GLU 166, GLN 189, CYS 44, SER 

46, PRO 168, CLA 6 

33 Morin -6,6 MET 49, ASN 142, HSE 41, SER 42 

34 Pachypodol -7,59 MET 49, MET 165, ARG 188, HSE 

41, LEU 167 

35 Daidzein -6,87 MET 49, MET 165, PRO 168 

36 Formononetin -7,02 MET 165, GLN 189, THR 190, PRO 

168, ARG 188 

37 Genistein -6,93 MET 165, GLN 189, THR 190, ARG 

188, PRO 168 
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Tabel VII.8 

Lanjutan 
 

No. Ligan ∆G 

(kkal/mol) 

Residu Asam Amino 

38 Biokanin A -7,13 MET 165, GLN 189, THR 190, ARG 

188, PRO 168 

39 Orobol -7,05 CYS 145, GLU 166, GLN 188, PRO 

168, HSE 41 

40 Tectorigenin -6,85 MET 49, MET 165, THR 190, HSE 

41, PRO 168 

41 Baptigenin -7,06 MET 165, GLN 189, THR 190, PRO 

168 

42 Pinocembrin -7,07 MET 165, CYS 145, GLU 166, GLN 

189, THR 190, PRO 168, LEU 167 

43 Liquiritigenin -7,09 MET 49, MET 165, CYS 145, GLU 

166, GLN 189, THR 190, PRO 168, 

LEU 167 

44 Narigenin -7,4 CYS 145, GLN 189, THR 190, PRO 

168, HSE 41, LEU 167 

45 Sakuranetin -7,57 MET 49, MET 165, GLU 166, ASN 

142, PHE 140, HSE 41 

46 Eriodictyol -7,69 CYS 145, GLN 189, THR 190, PRO 

168, HSE 41, LEU 167 

47 Hesperetin -7,56 MET 165, PRO 168, THR 190, LEU 

176, ARG 188 

48 Homeriodictyol -7,54 MET 165, PRO 168 

49 Parietin -7,22 MET 165, CYS 145,GLU 166 THR 

190, PRO 168, ARG 188 

50 Epigallocatechin -7,71 CYS 145, GLU 166, GLN 189, THR 

190, LEU 141 

51 Catechin -7,66 MET 165, CYS 145, GLU 166, GLN 

189, THR 190, PRO 168, ARG 188 

52 Naringin -9,84 MET 165, GLN 189, PHE 140 

53 Pinobanskin -7,04 GLU 166, CYS 145, PRO 168, THR 

190, ARG 188 

54 Aromadendrin -7,3 GLN 189, CYS 145, PRO 168, THR 

190, ARG 188, LEU 176, HSE 41 

55 Fustin -7,19 MET 165, GLU 166, ASN 142, PHE 

140, HSE 41 
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Tabel VII.8 

Lanjutan 

 

No. Ligan ∆G 

(kkal/mol) 

Residu Asam Amino 

56 Taksifolin -7,52 CYS 145, GLN 189, PRO 168, HSE 

41, ARG 188, LEU 167 

57 Agathisflavone -7,52 GLU 166 

58 Cupresuflavone -7,52 PRO 168, THR 190, ALA 191 

59 Ginkgetin -8,08 ARG 60, LYS 61 

60 Siadopitisin -8,07 CYS 145, GLU 166, PRO 168, LEU 

141, LEU 167 

61 Robustaflavone -7,35 GLN 189, THR 190, LEU 50 

62 Hinokiflavone -7,36 GLU 166, LEU 50 

63 Ochnaflavone -8,17 MET 49, GLN 189, PRO 168, HSE 

41 

64 Amentoflavone -7,74 MET 165, CYS 145, THR 190, PRO 

168, ASN 142 

65 Isoliquiritigenin -6,36 MET 49, MET 165, GLN 189, PRO 

168 

66 Khalkonarigenin -6,85 CYS 145, GLU 166, GLU 189, PRO 

168, THR 190, HSE 41 

67 Butein -6,79 GLU 166, PRO 168, PHE 140 

68 Okanin -6,74 GLN 189, CYS 145, PRO 168, HSE 

41 

69 Phloretin -7,34 MET 49, MET 165, GLU 166, ASN 

142, PHE 140, ARG 188, HSE 41 

70 Phlorizin -8,67 MET 49, CYS 145, GLU 166, ARG 

188, LEU 141, SER 46 

71 Sulfuretin -7,28 CYS 145, GLU 166, GLN 189, THR 

190, LEU 141, PRO 168 

72 Aureusidin -7,59 CYS 141, GLN 189, PRO 168, HSE 

41 

73 Maritimetin -7,84 MET 165, GLU 166, GLN 189, THR 

190, PRO 168, HSE 41, ARG 188 

74 Leptosidin -7,9 MET 49, MET 165, CYS 145, GLU 

166, THR 190, PRO 168 
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Tabel VII. 9  

Hasil penambatan senyawa Flavonoid pada reseptor SARS-COV-2 ID PDB 

7BUY 

No Ligan ∆G 

(kkal/mol) 

Residu Asam Amino 

1 Hexylcarbamic acid -6,49 PRO 168 

2 Lopinavir -9,89 MET 49, MET 165, ASN 142, HSE 

41, SER 46, THR 26 

3 Remdesivir -10,07 MET 145, ASN 142, CYS 145, 

GLU 166, GLN 189, GLY 143, 

THR 190 

4 Apigenin -6,72 PRO 168, MET 165, HSE 41 

5 Baicalein -6,91 PRO 168, MET 49, MET 165, 

GLN 189, THR 190 

6 Chrysin -6,86 MET 49, MET 165, CYS 145, 

GLU 166, GLY 143 

7 Luteolin -7,1 MET 49, ASN 142, CYS 145, HSE 

41 

8 Scutelarein -7 MET 49, MET 165, CYS 44, CYS 

145, GLU 166, GLY 143 

9 Hispidulin -7,09 MET 49, MET 165, CYS 145, 

GLU 166, GLY 143, LEU 141 

10 Chrysoeriol -7,28 PRO 158, MET 165, HSE 41 

11 Tricetin -6,97 PRO 158, MET 165, HSE 41 

12 Tangeretin -8,29 MET 49, MET 165, CYS 145, 

GLU 166,GLN 192, LEU 141, 

THR 190 

13 Wogonin -7,19 MET 49, MET 165, CYS 145, 

GLU 166,GLY 143 

14 Rhoifolin -9,13 MET 49, GLU 166, SER 46, ARG 

188, HSE 41, LEU 50 

15 Diosmetin -7,15 MET 49, MET 165, CYS 145, ASN 

142, HSE 41, ARG 188 

16 Acacetin -7,17 PRO 168, MET 165, GLU 166, 

GLN 192, THR 190 

17 Tricin -7,62 PRO 168, MET 165, HSE 41 

18 Galangin -6,71 MET 49, MET 165, CYS 145, 

GLU 166, GLY 143 

19 Fisetin -7,01 PRO 168, MET 165, HSE 41, ARG 

188, GLN 192 



134 

 

 

LAMPIRAN 12 

(LANJUTAN) 

 
Tabel VII.9 

Lanjutan 

 

No Ligan ∆G 

(kkal/mol) 

Residu Asam Amino 

20 Kaemferol -6,88 PRO 168, MET 165, GLU 166, 

THR 190, GLN 192 

21 Kaemferide -7,06 MET 165, ARG 188, THR 190, 

LEU 141 

22 Robinetin -7,04 PRO 168, MET 165, HSE 41, ARG 

188, GLN 192 

23 Herbasetin -6,9 MET 49, CYS 145, GLY 143 

24 Quercetin -6,76 MET 49, MET 165, GLU 166, PHE 

140 

25 Ramnetin -7,65 MET 49, MET 165, GLY 143, PHE 

140, ARG 188 

26 Isoramnetin -7,15 PRO 168, MET 165, HSE 41, ARG 

188, ARG 188 

27 Myricetin -6,99 MET 49, MET 165, CYS 143, HSE 

41, CYS 44, GLY 143 

28 Querstagenin -7,02 PRO 168, MET 49, MET 165, 

ARG 188, THR 190 

29 Gossypetin -7,15 MET 49, CYS 44, CYS 145, GLU 

166, GLY 143 

30 Isoquercetin -8,67 MET 165, ASN 142, GLU 166, 

PHE 140 

31 Ramnazin -7,73 MET 165, GLY 143, PHE 140 

32 Rutin -8,97 ASN 142, GLU 166, LEU 141 

33 Morin -6,69 MET 165, ASN 142, GLU 166, 

GLY 143 

34 Pachypodol -8,09 MET 49, MET 165, CYS 145, 

GLU 166, GLY 143, ARG 188, 

PHR 140 

35 Daidzein -7 MET 165, CYS 145, GLU 166, 

GLY 143, THR 190 

36 Formononetin -7,39 MET 165, CYS 145, GLU 166, 

GLY 143, THR 190 

37 Genistein -7,05 MET 165, CYS 145, GLU 166, 

GLY 143, ARG 188 

38 Biokanin A -7,35 MET 165, CYS 145, GLU 166, 

GLY 143, THR 190 
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Tabel VII.9 

Lanjutan  
 

No Ligan ∆G 

(kkal/mol) 

Residu Asam Amino 

39 Orobol -7,06 MET 165, CYS 145, GLU 166, 

GLY 143, ARG 188 

40 Tectorigenin -7,33 MET 165, CYS 165, GLY 143, 

ARG 188 

41 Baptigenin -7,28 MET 165, CYS 145, GLU 166, 

GLY 143, ARG 188 

42 Pinocembrin -7,32 PRO 186, MET 49, MET 165, LEU 

167, THR 190 

43 Liquiritigenin -7,19 MET 165, THR 190 

44 Narigenin -7,16 MET 49, MET 165, CYS 44, CYS 

145, GLU 166, GLY 143 

45 Sakuranetin -7,39 PRO 186, MET 49, HSE 41, LEU 

167, THR 190 

46 Eriodictyol -7,23 MET 165, ASN 142, GLU 166, 

ARG 188 

47 Hesperetin -7,54 MET 165, CYS 145, GLU 166, 

GLY 143, ARG 188, THR 190 

48 Homeriodictyol -7,52 PRO 168, MET 49, MET 165, HSE 

41, THR 190 

49 Parietin -7,31 MET 49, MET 165, CYS 145 , 

THR 190, ARG 188 

50 Epigallocatechin -7,53 MET 165, CYS 143, HSE 164, 

HSE 41, SER 144, GLU 166, GLY 

143 

51 Catechin -7,27 MRT 165, GLU 166, HSE 164, 

LEU 141 

52 Naringin -9,69 MET 49, CYS 44, CYS 145, GLU 

166, GLY 143, SER 144, ARG 

188, LEU 141 

53 Pinobanskin -7,05 PRO 168, MET 49, MET 165, THR 

190 

54 Aromadendrin -7,19 PRO 168, MET 165, HSE 41, LEU 

167, THR 190, ARG 188 

55 Fustin -7,27 MET 165, ASN 142, GLU 166, 

PHE 140 
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Tabel VII.9 

Lanjutan 

 

No Ligan ∆G 

(kkal/mol) 

Residu Asam Amino 

56 Taksifolin -7,39 MET 165, GLU 166, LEU 141, 

HSE 164 

57 Agathisflavone -8,02 CYS 145, ASN 142, GLY 143, 

TYR 118 

58 Cupresuflavone -7,78 MET 49, MET 165, ASN 142, 

GLU 166, GLY 143 

59 Ginkgetin -8,96 PRO 168, MET 49, MET 165, CTS 

145, HSE 41, THR 190, ASN 142, 

PHE 140, GLY 143, 

60 Siadopitisin -8,4 MET 49, CYS 145, ASN 42, GLY 

143, PHE 140 

61 Robustaflavone -7,35 MET 145, ASN 142, GLU 166, 

GLY 143, THR 24 

62 Hinokiflavone -8,02 MET 49, MET 165, HSE 41, THR 

24, THR 45, GLY 23 

63 Ochnaflavone -8,68 PRO 168, MET 49, MET 165, CYS 

145, HSE 41, THR 26, THR 190 

64 Amentoflavone -8,4 PRO 168, MET 49, MET 165, 

GLLU 166, GLN 143, HSE 41 

65 Isoliquiritigenin -6,85 MET 165, CYS 145, GLU 166, 

GLY 143, THR 26 

66 Khalkonarigenin -7,07 MET 49, MET 165, ASN 142, HSE 

41 

67 Butein -7,28 MET 49, 165, CYS 44, ARG 188, 

HSE 41 

68 Okanin -7,18 CYS 145, ASN 142, GLU 166, 

LEU 141, LEU 26 

69 Phloretin -7,43 MET 49, MET 165, ASN 142, CYS 

145, SER 144 

70 Phlorizin -8,65 PRO 168, GLU 166, THR 190 

71 Sulfuretin -7,44 MET 165, CYS 145, GLY 143, 

LEU 141, ARG 188 

72 Aureusidin -7,63 MET 49, MET 165, HSE 41, ASN 

142, PHE 140, ARG 188 

73 Maritimetin -7,48 PRO 168, MET 49, MET 165, 

GLU 166, THR 190 
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Tabel VII.9 

Lanjutan 
 

No Ligan ∆G 

(kkal/mol) 

Residu Asam Amino 

74 Leptosidin -7,73 MET 165, CYS 145, GLU 166, 

GLY 143, LEU 141, ARG 188 
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